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1. Crearea unui site 
1.1. Etapele realizării site-ului 

Planificarea site-ului conţine următoarele etape: 

• Stabilirea audienţei 

• Stabilirea scopului 

• Definirea obiectivelor 

• Colectarea informaţiilor despre subiectul prezentat 

• Stabilirea specificaţiilor 

• Stabilirea modului de prezentare 

 
Design-ul site-ului 

Odată parcursă etapa de planificare, având clare audienţa, scopul, obiectivele şi specificaţiile site-

ului, se trece la etapa de creare efectivă. 

În faza de concepere a designului principalul obiectiv este să creăm un aspect atractiv şi să oferim 

vizitatorului site-ului un sentiment de satisfacţie, pe măsură ce acesta parcurge paginile. Designul 

unui site trebuie să echilibreze performanţele browserului, cu estetica şi funcţionalitatea site-ului. În 

etapa de design sunt luate deciziile de ordin practic care vor conduce la îndeplinirea obiectivelor 

stabilite: câte imagini sau elemente grafice vom include în pagină, cât de mult text vor conţine 

paginile, ce texte sau imagini vor fi folosite drept legături. 

 
Stabilirea 
audienței 

 
Stabilirea 
scopului 

 
Obiective 

 
Colectare 
informații 

 
Specificații 

 
Prezentare 
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Implementarea site-ului 

Această etapă reprezintă introducerea textului în pagini, crearea navigaţiei în site, crearea legăturilor 

între pagini, crearea diferitelor formulare şi procesarea rezultatelor acestora. 

În această etapă se face şi traducerea site-ului în diferitele limbi în care va fi acesta disponibil. toate 

elementele grafice ale site-ului se definitivează, toate pozele sunt puse la locul lor, galeriile de poze 

sunt create, filmele şi alte elemente sunt puse în pagina. 

 

Testarea site-ului 

Etapa de design a site-ului se desfăşoară în strânsă legătură cu cea de implementare, de scriere a 

codului HTML pentru paginile care fac parte din site. Totuşi, procesul de creare a site-ului nu se 

poate considera încheiat în momentul finalizării tuturor documentelor HTML care îl formează. 

Urmează o etapă adesea tratată oarecum superficial, deşi, ca şi celelalte, este esenţială pentru 

construirea unui site de calitate: etapa de testare. 

Etapa de testare consta în corectarea tuturor greşelilor ortografice şi gramaticale, testarea tuturor 

legăturilor dintre paginile site-ului şi verificarea validităţii codului HTML pentru o mai bună 

indexare de motoarele de căutare. 

 

Publicarea site-ului 

În cadrul acestei etape site-ul este înscris pe motoarele de căutare pentru că acestea să îl analizeze şi 

să îl introducă în rezultatele căutărilor. 

 

Antet Site 

Meniu 

Conținut  



5 
 

Optimizarea pentru motoarele de căutare 

Ideea este destul de simplă, cu cât vor fi mai mulţi vizitatori pe site, cu atât produsele/serviciile 

promovate vor fi vizualizate de mai mulţi potenţiali clienţi. Optimizarea pentru motoarele de căutare 

reprezintă identificarea cuvintelor cheie pentru obiectul de activitate al site-ului şi suită de modificări 

făcute site-ului pentru a ajunge în poziţii de top pe motoarele de căutare astfel încât acesta să 

primească mai mulţi vizitatori. 

Nu este suficient ca un site să se afle pe internet pentru a fi găsit de către vizitatori, el trebuie să fie 

uşor de găsit de către aceştia. De asemenea vizitatorii trebuie să se afle în publicul țintă a site-ului. 

 

 

1.2. Crearea și editarea unei pagini web 
 

1.2.1. Alegerea programului de editare 
Exista o multitudine de programe pe care le putem folosi la crearea paginilor web. 

Editoarele de text sunt cele mai simple editoare care permit crearea si salvarea fișierelor fără coduri 

de formatare ascunse, care pot afecta modul de afișare a unei pagini web in browser. 

Editoarele specializate HTML le permit utilizatorilor sa creeze documente web intr-un mod rapid si 

ușor si, prin urmare, foarte eficient, doar prin apăsarea câtorva butoane sau prin apelarea câtorva 

funcții predefinite. In loc de a scrie de mână codul sursa HTML, aceste programe generează ele 

însele acest cod. Chiar si in acest caz este necesară cunoașterea limbajul HTML pentru a putea edita 

codul si a înlătura eventualele neajunsuri din documentele web. 

 

Notepad++ 

Acesta este un editor gratuit de cod-sursa care suporta mai multe limbaje de programare si rulează 

sub Windows. Ofera facilitati precum Syntax Highlighting, stiluri personalizate, editare simultana a 

mai multor fișiere, multiview si bookmarks. Acest produs este sub licenta GPL (General Public 

License). Programul poate fi gasit la adresa http://notepad-plus.sourceforge.net. 

Datorita folosirii unor culori diferite, acest program permite o distingere clara a elementelor, 

atributelor si valorilor, contribuind in acest fel la înțelegerea noțiunilor generale de programare. 

Tipul de limbaj folosit se selectează din meniul Language, de exemplu HTML. 
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In Notepad++ codurile unui document HTML se vor vedea astfel: 

 
 

 

1.2.2. Interfața aplicației Adobe Dreamweaver CS6  
este un editor profesional de pagini Web, aflat în topul preferințelor designer-ilor Web din toată 

lumea, oferind o interfață prietenoasă, intuitivă și ușor de folosit. 
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  Un element de noutate în această soluție software de Web design îl constituie posibilitatea de a crea 

și edita aplicații pentru dispozitivele mobile, destinate platformelor iOS și Android. Pentru aceasta, 

ne ajută opțiunea ”Fluid Grid Layout…”, din secțiunea Create New. 

 
 

La deschiderea aplicaţiei Adobe Dreamweaver,  fereastra de lucru va afişa pagina Web aşa cum va 

apărea ea în browser. În  fereastra de lucru putem crea și modifica pagina HTML. În aplicația Adobe 
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Dreamweaver paginile Web pot fi create atât în modul grafic (Design), cât și direct în cod HTML 

(Code). 

Bara de aplicație (Application bar) conține meniurile aplicației, comutatorul spațiului de lucru  și 

alte controale de aplicație (Layout, Extend Dreamweaver, Site) 

Bara de instrumente Document ( Document toolbar) este creată pentru a oferi posibilitatea 

accesului rapid la comenzile mai importante.Conține butoane pentru diferite moduri de vizualizare 

ale ferestrei Document (Code, Split, Design), Multiscreen (vizualizăm documentul HTML ca și cum 

ar apărea în ecrane de diferite dimensiuni), pentru examinarea într-un browser configurat 

(Preview/Debug in browser), pentru verificarea compatibilității foilor de stil (CSS) cu diferite 

browsere (Check browser compatibility). 

Modul de vizualizare Code permite scrierea și editarea codului HTML, JavaScript, PHP sau 

ColdFusion Markup Language (CFML), precum și a oricărui alt tip de cod. 

Modul de vizualizare Split permite afișarea în fereastra Document  atât a codului sursă, cât și  a 

reprezentării vizuale a documentului HTML. 

Modul de vizualizare Design este un mediu de editare vizuală și dezvoltare rapidă de aplicații, care 

afișează o reprezentare vizuală a documentului, asemănătoare cu cea din fereastra browser-ului. 

Live View este similar modului de vizualizare Design, afișând o reprezentare mai apropiată de ceea 

ce documentul HTML va arăta în browser. Acest mediu permite interacțiunea cu documentul la fel ca 

într-un browser. În modul Live View conținutul documentului HTML nu este editabil. 

Live Code View este disponibil doar atunci când vizualizăm un document în modul Live View. În 

modul Live Code View nu avem posibilitatea să edităm codul sursă al paginii HTML. 

Crearea și salvarea unei pagini noi 

Pentru a crea un document nou vom alege File à New și se va deschide caseta de dialog New 

Document. 

Opțiunea de creare a unei pagini noi HTML poate fi găsită în categoria Blank Page. 
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Salvarea documentelor 

Putem salva un document folosind numele și locația sa curentă sau putem salva o copie a unui 

document folosind un alt nume şi o altă locaţie. 

Pentru a salva fișierul cu modificările făcute în locația curentă alegem File à Save. 

Pentru a salva fişierul într-un alt folder sau cu ajutorul unui alt nume, selectăm File à Save As… 

Pentru salvarea tuturor documentelor deschise se va alege File à Save all. Dacă există un document 

nesalvat printre documentele deschise, se va afișa caseta de dialog Save as… pentru fiecare astfel de 

document. 

Pentru a reveni la ultima versiune salvată a unui document vom selecta File à Revert. 

O casetă de dialog ne va întreba dacă dorim să renunţăm la modificările făcute şi să revenim la 

versiunea anterioară salvării. 

Observație: 

Dacă salvăm un document şi apoi ieşim din aplicație, nu putem reveni la versiunea anterioară a 

documentului atunci când vom reporni Adobe Dreamweaver. 

Stabilirea titlului documentului HTML: efectuăm clic-dreapta pe o porţiune liberă din 

fereastra Document şi selectăm din meniul contextual opțiunea Page Properties. Va apărea caseta de 

dialog Page Properties, în care se introduce un titlu sugestiv în caseta Title. 
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1.2.3. Stabilirea paletei cromatice 
În Adobe Dreamweaver culorile pot fi introduse direct în caseta de text prin valori hexazecimale 

precedate de semnul # (de exemplu, pentru culoarea roșu folosim valoarea hexazecimală #FF0000) 

sau pot fi alese din paleta de culori pusă la dispoziție de aplicație. Valorile sunt selectate RGB, 

primele două cifre reprezintă Red – roşu, următoarele două, reprezintă Green – verde şi ultimele două 

reprezintă Blue – albastru. Pentru a seta culorile dorite pentru text și fundalul paginii Web deschidem 

fereastra Page Properties. 
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 Alegerea culorilor se face utilizând selectorul de culoare în mai multe moduri, din cele cinci 

panouri disponibile: 

– Color cubes – cuburi de culoare; 

– Continuous tone – tonuri continue; 

În Adobe Dreamweaver, cuburile de culoare şi paletele de ton continuu utilizează paleta de 

216-culori sigure pentru web (web-safe color). O culoare sigură pentru web este o culoare care apare 

la fel în orice browser,  pe ambele sisteme Windows şi Macintosh, atunci când rulează în modul de 

256-culori.  Selectând o culoare din paleta de 216 culori sigure se afişează valoarea hexazecimală a 

culorii. 

– Windows OS – nuanțe de culoare standard pentru sistemul de operare Windows; 

– Mac OS – nuanțe de culoare standard pentru sistemul de operare Macintosh; 

– Grayscale – gama de griuri. 

În acelaşi fel este stabilită culoarea de fundal, care are valoarea implicită #FFFFFF – alb. Trebuie 

verificat ca pagina să fie uşor de citit. Dacă aplicăm o culoare deschisă de fundal, este recomandabil 

să setăm culori închise pentru text. Adobe ne vine în ajutor cu aplicația Adobe Kuler – aplicație Web, 

disponibilă gratuit on-line, pentru generarea temelor de culori (http://kuler.adobe.com/). 

 Marginile paginii pot fi setate tot în fereastra Page Properties. 

Tag-urile Paragraph și Break 

Tag-ul Paragraph  <p>…</p>  include un bloc de text. 

Crearea unui nou paragraf se face apăsând tasta Enter, în modul de vizualizare Design. 

Tagul Break  <br>  este un tag fără conținut. 

Tagul Break semnalează ruperea rândului și are ca efect trecerea la o linie nouă. 
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1.2.4. Formatarea textului 
Formatarea textului în Adobe Dreamweaver se realizează utilizând lista Format din fereastra de 

inspectare Property. 

 
  

Sunt patru opţiuni de bază în formatarea textului: 

1. None – anulează orice stil de formatare aplicat secţiunii dorite. 

2. Paragraph – aplică secţiunii tag-urile <p> … </p>. 

3. Headings 1- 6 – aplică secţiunii tag-uri de antet. H1 este cel mai mare antet ca dimensiune, iar H6 

este cel mai mic. 

4. Preformatted – afişează textul în font cu dimensiune fixă în funcţie de setările sistemului. 

În meniul Format găsim opțiunea Paragraph Format, care ne ajută să stabilim dimensiunea textului. 

Titlurile Headings 1- 6 pot fi utile pentru a împărți conținutul în secțiuni și pentru a atrage atenția 

asupra anumitor părți ale paginii. Formatarea textului cu titluri ne ajută să diferențiem conținutul 

paginii, creând astfel o ierarhie clară. 

Alinierea textului 

Pentru alinierea textului avem patru opțiuni de bază: 

§ Align Left (aliniere la stânga) 

§ Align Center (aliniere la centru) 

§ Align Right (aliniere la dreapta) 

§ Justify (aliniere stânga – dreapta) 

 

1.2.5. Adăugarea unei hiperlegături în pagină 
Pentru a putea crea o hiperlegătură trebuie să avem în directorul site-ului Web cel puţin două pagini 

sau putem realiza  hiperlegături la adrese Web. 

Un link din HTML cuprinde două părți: numele sau calea (sau URL-ul – Uniform Resource Locator) 

fișierului cu care dorim să facem legătura, respectiv textul sau grafica zonei pe care se face clic. 
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Atunci când un utilizator efectuează clic pe un link, browser-ul încarcă documentul legat de acel link. 

Link-urile pot redirecționa utilizatorul către alte documente HTML, imagini sau alte elemente media. 

Crearea link-urilor Hypertext 

Link-urile hypertext oferă posibilitatea de a redirecționa vizitatorul către documente din pagina Web 

sau către altă locație de pe Internet. Link-urile realizate în cadrul aceluiași site poartă numele de link-

uri relative și pot face legătura cu fișiere din orice locație. 

Este foarte important să salvăm documentul înainte de  a crea legături. Operația de salvare a unui 

fișier comunică aplicației Dreamweaver locația documentului și permite programului să determine 

calea link-ului. Dacă vom crea un link fără a salva în prealabil documentul, toate aceste căi vor 

începe cu file:// și nu vor lucra pe site-urile găzduite de alte servere, deoarece aceste căi sunt relative 

cu hard discul pe care s-a lucrat și nu cu fișierul în care este link-ul. 

Specificarea culorii și formatului link-ului 

Alegerea unei culori pentru link, care să se evidențieze de restul textului, permite observarea cu 

ușurință a acestuia de către vizitatori. Dacă nu se specifică culoarea link-ului, setările implicite ale 

browser-ului vor fi folosite atunci când pagina este deschisă de către browser-ul vizitatorului. Aceste 

setări implicite pot să difere de la un browser la altul. Culorile selectate ar trebui să fie în contrast, 

fără a interfera cu fundalul și cu alte elemente, astfel încât link-urile să fie vizibile. 

Pentru aceasta, alegem din meniul Modify ->Page Properties și apoi selectăm Links (CSS). 

 
 Putem defini culori pentru cel mult patru stări diferite ale unui link: 

§ Link Color – culoarea inițială a unui link, înainte de a se face clic pe acesta; 

§ Visited Link – culoarea link-ului după ce utilizatorul a efectuat clic pe acesta; 

§ Rollover Links – culoarea unui link atunci când utilizatorul staționează cu cursorul pe un link; 

§ Active Links – culoarea link-ului în momentul în care link-ul este apăsat. 

Utilizarea de Ancore în pagini lungi 
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Atunci când un site Web are mai multe secţiuni este utilă realizarea de hiperlegături cu 

ajutorulAncorelor cu nume (Named Anchor). 

Pentru aceasta se introduce o ancoră cu nume în locul din pagină unde va fi deplasat vizitatorul, apoi 

se creează o hiperlegătură care este legată la ancora cu nume. 

Etapele de realizare sunt următoarele: 

§ Selectăm comanda Named Anchor din meniul Insert; 

§ Introducem un nume în caseta de dialog Named Anchor şi dăm clic pe butonul OK; 

§ În locul unde am inserat ancora cu nume, va apărea un element invizibil cu o ancoră pe el. 

Pentru a realiza o legătură la noua ancoră trebuie să selectăm textul la care vom face legătura, iar în 

caseta Link vom introduce numele ancorei precedat de semnul #. 

Cu ajutorul aplicaţiei Adobe Dreamweaver putem să inserăm în pagină o legătură care să permită 

vizitatorului să transmită un e-mail. Această legătură va funcţiona doar dacă utilizatorul are 

configurată o aplicaţie de tip e-mail. 

Selectăm textul care urmează a fi legat la un e-mail, alegem meniul Insert à Email Link și va apărea 

caseta Insert Email Link. Introducem adresa de e-mail dorită şi apăsăm OK. 

Se deschide caseta de dialog Email Link. 

În câmpul Text va apărea textul selectat, iar în câmpul E-mail se introduce adresa de e-mail. Textul 

va apărea pe pagină sub forma unui link. Inspectorul Property va afișa mailto: urmat de adresa de e-

mail, în câmpul de text Link, atunci când se poziționează cursorul în interiorul link-ului. 

 

1.2.6. Inserarea și formatarea listelor 
Într-o pagină Web putem crea trei tipuri de liste: ordonate, neordonate și de definiție. 

În fereastra de inspectare Property se găsesc butoanele Ordered List și Unordered List, respectiv lista 

ordonată și lista neordonată. 
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Pentru crearea unei liste ordonate vom proceda în felul următor: 

§ Introducem un număr de elemente apăsând tasta Enter după fiecare element; 

§ Selectăm elementele; 

§ Apăsăm butonul Ordered List din fereastra Property. 

sau folosim meniul Format -> List  -> Ordered List. 

Pentru crearea unei liste neordonate vom proceda în felul următor: 

§ Introducem un număr de elemente apăsând tasta Enter după fiecare element; 

§ Selectăm elementele; 

§ Apăsăm butonul Unordered List din fereastra Property. 

sau folosim meniul Format -> List -> Unordered List. 

O listă de definiție constă într-o serie de termeni împreună cu definițiile acestora. Cuvântul sau 

termenul care va fi definit este aliniat la stânga, iar definiția este indentată și plasată pe următoarea 

linie. În fața termenilor nu există caractere speciale, așa cum există în fața listelor ordonate sau 

neordonate. 

Pentru a insera o listă de definiție vom proceda în felul următor: 

§ Introducem cuvintele și definițiile corespunzătoare, apoi selectăm textul care dorim să devină o listă 

de definiții și alegem din meniul Format -> List -> Definition List. 

 Pentru a înlătura formatările listei sau pentru a trece la alt tip de listă, selectăm întreaga listă și 

efectuăm clic pe butonul sau pe opțiunea corespunzătoare listei din inspectorul Property sau din 

meniul Format. Dacă dorim să schimbăm tipul listei efectuăm clic pe tipul opus de listă. Dubla 

apăsare a tastei Enter determină ieșirea din listă și începerea unui paragraf nou. 
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Pentru a alege tipul listei sau stilul dorit putem folosi Format -> List à Properties, deschizând astfel 

caseta de dialog List Properties. 

 

Meniul List Type din caseta de dialog List Properties conține alte tipuri de liste: Bulleted list, 

Numbered list, Directory list și Meniu list. Din meniul Style putem alege tipul 

marcatorilorBullet sau Square. 

Culorile numerelor și punctelor care sunt folosite atât în listele ordonate, cât și în cele neordonate 

sunt bazate pe setările de bază pentru culoarea textului. 

 

1.2.7. Inserarea şi formatarea tabelelor 
Tabelele sunt folosite pentru a organiza informaţia pe o pagină Web. 

 Crearea unui tabel 

Un tabel poate avea una sau mai multe celule. Celula reprezintă zona creată la intersecția unui rând 

cu o coloană. Un tabel va avea cel puțin un rând, ceea ce va crea implicit o celulă. Pentru a insera un 

tabel în Adobe Dreamweaver CS6, selectăm Insert -> Table din meniul principal sau putem folosi 

combinația de taste Ctrl+Alt+T. 
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Se deschide caseta de dialog Table: 

 
 Caseta de dialog Table este împărțită în trei secțiuni: Table size, Header și Accessibility. 

În secțiunea Table size regăsim opțiunile: 

§ Rows – numărul rândurilor tabelului; 

§ Columns – numărul coloanelor; 

§ Table width – lățimea tabelului în pixeli sau într-un procentaj de mărimea ferestrei browser-ului; 

§ Border Thickness – lățimea marginilor tabelului; 

§ Cell padding – mărimea spațiului dintre conținutul celulei și pereții celulei. Dacă nu completăm 

această opțiune, fundalul celulei are implicit valoarea de 1 pixel. 
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§ Cell spacing – mărimea spațiului dintre celulele tabelului, fără a include marginea tabelului. Dacă nu 

completăm această opțiune, setarea implicită este de 1 pixel. Dacă nu dorim spațiu între celule, atunci 

trecem valoarea 0 în acest câmp. 

Secțiunea Header conține patru opțiuni diferite pentru poziționarea unui antet: None, Left, 

Top șiBoth. Vom folosi un header doar pentru tabelele de date, nu și pentru tabelele de așezare în 

pagină. 

Secțiunea Accessibility include următoarele opțiuni: 

§   Caption – folosită pentru a realiza o descriere; 

§   Summary – reprezintă un sumar al tabelului, care nu apare în pagina Web, dar este folosit pentru a 

explica scopul și conținutul unui tabel. 

Formatarea celulelor tabelului 

Putem schimba culoarea de fundal sau alinierea pentru o celulă sau pentru mai multe celule selectate. 

Pentru a selecta mai multe celule neadiacente ținem apăsată tasta Ctrl și efectuăm clic pe celulele pe 

care dorim să le selectăm. 

Pentru a modifica culoarea de fundal a celulelor folosim inspectorul Properties. 

Adăugarea unui titlu de tabel 

Adăugarea unui titlu de tabel se face astfel : 

1. plasăm cursorul imediat după tag-ul de deschidere a tabelului <table>; 

2. selectăm secţiunea Table  Objects din meniul Insert; 

3. selectăm comanda Caption și se vor adăuga automat tag-urile <caption>…</caption>; 

4. introducem titlul dorit între tag-urile <caption>…</caption>; 

5. plasăm cursorul în interiorul tag-ului de deschidere <caption> şi apăsăm bara de spaţiu. Va apărea 

meniul derulant cu atribute. Selectând align alegem modul de aliniere a titlului de tabel. 
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Pentru a îmbina două sau multe celule adiacente, selectăm celulele și din meniul contextual 

alegem Table-> Merge Cellssau putem folosi meniul principal Modify ->Table -> Merge Cells. 

Pentru a împărți o celulă în mai multe rânduri și coloane, selectăm celula și din meniul contextual 

vom alege opțiunea Table -> Split Cellssau din meniul principal selectăm Modify->Table -> Split 

Cells. 
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1.2.8. Inserarea imaginilor 
Toate imaginile inserate într-o pagină Web sunt fișiere separate și nu fac parte din documentul 

HTML. Aplicația Adobe Dreamweaver permite vizualizarea imaginilor introduse în pagină, în 

fereastra Document. 

Pentru a insera o imagine în pagina Web trebuie să efectuăm următorii pași: 

1. Alegem locul unde dorim să inserăm imaginea; 

2. Din meniul Insert, selectăm comanda Image; 

3. Alegem imaginea dorită. În secțiunea Image preview, aflată în partea dreaptă a ferestrei Select 

Image Source, putem previzualiza imaginea. 

După inserare, putem efectua modificări ale dimensiunii imaginii. Prin micșorarea imaginii 

înDreamweaver, dimensiunea fișierului nu se reduce (transferul datelor va fi același). 

Pentru introducerea unui text alternativ la imagine trebuie să folosim caseta Alt text din fereastra de 

inspectare Properties. 

 
Pentru a realiza un hyperlink la o imagine procedăm astfel: 

§   Introducem URL-ul dorit în caseta Link a ferestrei de inspectare Properties; 

§   Utilizăm pictograma Browse și selectăm fișierul la care dorim să executăm link-ul. 

 
Cel mai mic element al unei imagini este pixelul (picture element). Rezoluția unei imagini este dată 

de lățimea și înălțimea în pixeli a imaginii respective. Un pixel admite un număr maxim de culori 

reprezentat de adâncimea de culoare. 

Există trei formate standard de imagine acceptate de browsere: GIF, JPEG și PNG. Aceste 

formate depind de rezoluţie, ceea ce înseamnă că dimensiunile unei imagini bitmap, inclusiv calitatea 

imaginii, se vor modifica la diferite setări de rezoluţie ale monitorului. 

În Adobe Dreamweaver CS6 imaginile pot fi optimizate selectând de pe bara de meniu Modify -

> Image -> Optimize… 



21 
 

 
Există și alte programe care ne ajută să optimizăm imaginile: Simply Good Pictures,  RIOT (Radical 

Image Optimization Tool), OptiPNG, PNGcrush, Online Image Optimizer ș.a. 

Putem seta în pagina Web o imagine de fundal direct într-o pagină individuală, din caseta de 

dialog Page Properties – această metodă creând un stil intern care este disponibil numai 

documentului căruia îi este aplicat. Pentru aceasta vom alege Modify -> Page Properties și vom 

selecta categoria Appearance. Apăsăm butonul Browse pentru a localiza imaginea de fundal. 

 
Dacă dorim să ștergem un grafic de fundal folosim caseta Page Properties, în care ștergem numele 

fișierului din câmpul de text Background image. 

Crearea efectului Rollover 

Cu ajutorul aplicației Adobe Dreamweaver putem să realizăm efectul Rollover la trecerea mouse-ului 

peste o imagine. Acest efect reprezintă de fapt o imagine care se suprapune peste o altă imagine 

atunci când cursorul mouse-ului se află deasupra imaginii. 

O imagine Rollover se obține astfel: 

1. Selectăm locul unde dorim să apară imaginea Rollover; 

2. Din meniul Insert selectăm Image objects -> Rollover Image; 

3. Apare caseta de dialog Insert Rollover Image. În prima casetă de sus completăm numele imaginii; 
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4. Selectăm apoi fișierele cu imaginile, cea inițială și cea cu efectul rollover, efectuând clic pe 

butoanele Browse corespunzătoare; 

5. Validăm caseta Preload Rollover Image, pentru ca imaginile să se încarce în cache-ul browserului. 

Dacă nu validăm această casetă, atunci când vizitatorul trece cu pointerul peste imaginea originală, 

tranziția dintre imagini nu se va efectua rapid. 

6. Adăugăm un text alternativ în caseta Alternate text; 

7. Efectuăm clic pe butonul OK. 

 

1.2.9. Adăugarea fișierelor Flash, a fișierelor de sunet și a applet-

urilor Java 
Elementele multimedia, incluzând filmele Adobe Flash, pot îmbogăți conținutul site-ului. Cu ajutorul 

acestor elemente, putem include animații și secvențe video care au rolul de a transmite diverse 

mesaje vizitatorilor site-ului. 

Există mai multe tipuri de fișiere multimedia care pot fi introduse într-o pagină Web (ex: .swf, .flv). 

Pentru a putea fi rulate, fișierele multimedia necesită un program care lucrează împreună cu browser-

ul. 

Putem să introducem într-un document Dreamweaver, pe lângă fișierele .swf  și .flv, 

QuickTime®Shockwave pentru a viziona conținut Web interactiv, applet-uri Java, controale ActiveX, 

alte obiecte audio sau video. 

Pentru aceasta plasăm punctul de inserare în fereastra Document în care dorim să introducem 

obiectul și inserăm obiectul urmând pașii: 

§ În meniul Insert efectuăm clic pe opțiunea Media şi selectăm tipul de obiect pe care dorim să-l 

inserăm. 

§ Dacă obiectul pe care dorim să-l inserăm nu este un obiect Shockwave, Applet sauActiveX, vom 

selecta opțiunea Plugin. Va apare o casetă de dialog, în care vom putea selecta un fişier sursă şi vom 

specifica anumiţi parametri pentru obiectul media introdus. 
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Inserarea filmelelor Shockwave 

Putem folosi Dreamweaver pentru a insera filme Shockwave. Adobe Shockwave , care reprezintă un 

standard pentru fișierele multimedia interactive pe Web, este un format comprimat, care permite 

descărcarea rapidă a fişierelor media create în aplicația Adobe  Director. 

 Adăugarea unui fișier de sunet 

Dacă dorim să inserăm un fișier de sunet în pagina Web vom efectua următoarele operațiuni: 

1. Alegem locul unde dorim să inserăm fișierul de sunet; 

2. Selectăm obiectul Plug–in din secțiunea Media a meniului Insert; 

3. În caseta de dialog Select File introduceți calea către fișierul de sunet. 

4. Efectuăm clic pe butonul Select. 

Inserarea unui applet Java 

Folosind Dreamweaver putem introduce un applet Java într-un document HTML. Java este un 

limbaj de programare care permite dezvoltarea de aplicaţii nu foarte complicate (denumiteapplet-uri) 

care pot fi încorporate în paginile Web. 

Inserarea unui applet Java se face astfel: 

1. Selectăm  Insert -> Media -> Applet. Se deschide caseta de dialog Select File. 

2. Navigăm  în directorul care conține appletul Java și selectăm fișierul dorit. 

3. Introducem parametrii ceruți de documentația applet-ului, selectând butonul Parameters. 

4. Salvăm pagina și o previzualizăm în browser. 

5. După introducerea unui applet Java, putem utiliza inspectorul de proprietăți pentru a seta 

parametrii. 
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1.3. Publicarea și testarea  site-ului            
 Înainte de a publica site-ul creat și de a-l face disponibil vizitatorilor ar trebui să verificăm: 

§   structura documentelor; 

§   erorile de sintaxă; 

§   optimizarea imaginilor; 

§   legăturile interne şi externe; 

Fiecărui site Web îi corespunde o adresă unică numită URL (Uniform Resource Locator). Un URL 

este format din: 

§   protocolul de transfer al datelor (ex: http:, https:); 

§   numele domeniului (ex: nume_domeniu.ro). 

Web-ul are la bază modelul client-server. Astfel, calculatoarele server stochează informații pe care le 

distribuie la cererea calculatoarelor client. Comunicarea între clienți și servere se realizează prin 

intermediul unui standard de comunicare, denumit HTTP (HyperText TransferProtocol). Hipertextul 

reprezintă o sumă de medii de comunicare statice (text, imagini, grafice) și dinamice (animații, 

sunete, filme) la care se adaugă capacitatea de a realiza legături (relații) între părțile componente 

ale documentelor multimedia. 

În cadrul World Wide Web, informația este organizată sub formă de pagini Web. O colecție de pagini 

Web formează o aplicație Web. 

Pentru a publica o aplicație Web avem nevoie de un server Web. Serverul Web poate să fie un 

calculator care îndeplinește funcția de transfer a informațiilor dintre serverul Web și browser-ul 

utilizatorului sau o aplicație instalată pe calculatorul personal cum ar fi Apache 2.4.1. și care face ca 

respectivul calculator să se comporte ca un server Web. Avem la dispoziție trei posibilități pentru 

publicarea site-ului Web: 

1. Internet Service Provider (ISP) – ex: Romtelecom, RDS 

2. Gazdă gratuită pe Internet (free host) – ex: 50.ro 
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3. Propriul server Web, instalat sub forma unei aplicații pe calculatorul personal – ex:serverul Apache, 

WampServer (care poate fi descărcat gratuit de la adresa http://www.wampserver.com/en/) sau 

EasyPHP (www.easyphp.org) 

Pentru a realiza publicarea paginilor Web trebuie să realizăm transferul fișierelor pe serverul Web. 

Această operație poartă numele de upload. 

Verificarea paginilor Web 

Aplicația Adobe Dreamweaver CS6 ne pune la dispoziție opțiunea File à Check Page, care ne ajută 

în verificarea compatibilității browser-elor și a legăturilor din cadrul site-ului. Din păcate, 

aplicația Adobe Dreamweaver CS6 nu dispune decât de dicționarul englez pentru verificarea 

gramaticală. Mozilla Firefox pune la dispoziția creatorilor de pagini Web un corector ortografic 

pentru limba română, foarte util, care poate fi descărcat de la adresa: https://addons.mozilla.org/en-

us/firefox/addon/romanian-spellchecking-diction/ . 

Generarea rapoartelor pentru site 

Generarea rapoartelor pentru site se realizează cu ajutorul comenzii Site -> Reports, care permite 

căutarea documentelor fără titlu (Untitled Documents), a marcajelor imbricate redundante 

(Redundant Nested Tags) sau ștergerea marcajelor goale (Removable Empty Tags). Rapoartele pot fi 

utilizate pentru un singur document, un folder sau tot site-ul. Rapoartele ne ajută să identificăm 

anumite probleme înainte de publicarea site-ului. 
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Întreţinerea şi actualizare a site-ului 

Întreţinerea site-ului va avea în vedere frecvenţa de actualizare, îmbunătățirile sau modificările 

aduse, informații şi resurse de actualitate, comentariile sau recomandările vizitatorilor, poziţia în 

clasamentul motoarele de căutare etc. 

Actualizarea site-ului trebuie făcută periodic prin adăugarea de informații noi, realizarea unei 

versiuni multilingve sau pentru a corecta problemele care au apărut după publicare. După ce a 

devenit operațional, site-ul va trebui actualizat la intervale regulate de timp având în vedere 

îmbunătăţirea unor caracteristici tehnico-funcţionale, adăugarea de noi opţiuni, actualizarea 

conţinutului informaţional etc. 

 

Promovarea site-ului 

Pentru a creşte numărul de vizitatori, administratorul site-ului trebuie să dea  posibilitatea 

utilizatorilor să-şi exprime opiniile, sugestiile şi comentariile în legătură cu site-ul vizitat. Această 

metodă, care poartă denumirea de metoda feedback-ului, este foarte des folosită, reprezentând în 

acelaşi timp o soluţie de publicitate on-line pentru companii. O soluție pentru primirea feedback-ului 

de la vizitatorieste folosirea email–ului care reprezintă o cale simplă de a recepţiona mesaje de la 

cititori. 

O metodă modernă de promovare a site-ului o reprezintă promovarea pe baza rețelelor sociale. Dintre 

cele mai cunoscute și utilizate rețele sociale amintim:  Facebook, Twitter, Linkedin, YouTube etc. În 

anul 2012, reţeaua de socializare Facebook a depășit oficial pragul de 1 miliard de utilizatori activi 

lunar, Twitterare peste 200 de milioane utilizatori activi, LinkedIn aproximativ 150 milioane, 

iar YouTubepeste 490 de milioane de vizitatori unici. 

Avantajele promovării site-ului cu ajutorul rețelelor sociale: 

§   Simplitatea, nu implică decât o conexiune la Internet; 

§   Interacțiunea cu posibilii vizitatori ai site-ului, aflându-le astfel părerile în legătură cu     conținutul 

și informațiile puse la dispoziție pe site; 

§   Dialogul bazat pe schimburi de idei, care îmbracă formal mesajul publicitar; 

§   Fidelizarea vizitatorilor, prin intermediul comentariilor, a review-urilor, a like-urilor pe Facebook 

sau a mesajelor pe Twitter. 
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2. Introducere în designul publicaţiilor 

Mijloace folosite 

Toate elementele designului – caracterul, ilustraţiile, hârtia, cerneala, fotografia, 

culoarea,aranjamentul paginii – sunt mijloace prin care se comunică idei, şi de aceea toate implică 

unproces de decizie. Toate comunică ceva, deci este important să ne gândim ce spun ele de fapt 

cititorului. 

Modele şi formate 

Standard  
• De regulă format A4 

•Cele mai multe publicaţii folosesc acest model 

•Se potriveşte cu mărimile standard ale reclamelor 

Digest  
• De regulă de format A5 

•Mic şi uşor de purtat 

•Degajă un sentiment de prietenie şi intimitate 

Tabloid  
•De regulă are dimensiunile de 30 x 24 cm. 

•Tipărit de regulă pe hârtie care este un pic mai bună decât hârtia de ziar dar nu la fel debună ca şi 

hârtia standard a majorităţii revistelor. 

•De regulă este tipărită în una sau două culori, pentru că policromia (tiparul în patruculori) este 

de slabă calitate pe acest tip de hârtie. 

•Degajă un sentiment de vitalitate şi de actualitate 

Newsletter (buletin informativ)  
•Dimensiunea aproximativ A4, deşi poate varia. 

•Costurile de producţie şi expediere sunt mici (fiindcă are mai puţine pagini) 

•De cele mai multe ori nu sunt necesare cheltuieli de legare 

•Este o soluţie practică pentru publicaţiile mic 
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3. Crearea unei publicații tipărite 
 

3.1. Diferența dintre imaginea vectorială și imaginea bitmap 
Imaginea vectorială este definită matematic ca o serie de puncte unite de linii. Elementele grafice 

într-o imagine vectorială sunt numite obiecte. Fiecare obiect este o entitate de sine stătătoare, cu 

proprietăți bine definite: culoare, forma, contur (outline), dimensiuni (latime, lungime) și poziția sa 

pe ecran, incluse în definiția sa. Cel mai mare avantaj al imaginii vectoriale este ca se pot modifica 

proprietățile oricărui obiect din compoziție, fără a-și pierde din calități si fără a afecta nici unul dintre 

celelalte obiecte. Acest lucru este posibil tocmai datorita faptului ca fiecare obiect este o imagine 

vectorială. Imaginile vectoriale sunt independente față de rezoluție. Aceasta înseamnă ca ele sunt 

afișate la rezoluția maxima a perifericelor de ieșire folosite (ex. monitor, imprimantă). 

 

 

 

3.2. Utilizarea aplicației Corel DRAW pentru prelucrări de 

imagini vectoriale 
 

CorelDRAW este un program complex de desen vectorial utilizat pentru crearea desenelor 

profesionale, de la simple sigle la desene tehnice foarte complexe. 

CorelDRAW permite două moduri grafice de lucru: 

• bitmap ~ imaginile sunt construite din puncte (pixeli). 

• vectorial ~ imaginile sunt formate din primitive grafice (vectori, curbe Bézier, obiecte grafice 

compuse din elemente cu diverse atribute).  

 

3.2.1. Crearea unui fişier nou în CorelDRAW: 
După lansarea în execuţie a utilitarului şi acesta pune la dispoziţia utilizatorului printr-o fereastră 

specială tipurile de fişiere disponibile: 
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Creare fişier nou pe baza unui şablon predefinit Deschidere fişiere recent utilizate 

 

 

 

Deschidere fişiere 

 

Creare fişier nou pe baza 
unui şablon ales 

 

Operaţii demonstrative 
pentru lucrul în 
CorelDRAW 

 

Noutăţi despre utilitar 

 

 

3.2.2. Salvarea unui fișier: 
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3.2.3. Bara de instrumente de desenare a aplicației CoreDRAW: 
 

După selectarea unui anumit obiect, bara de proprietăţi a ferestrei se modifică corespunzător 

caracteristicilor obiectului respectiv. 

 
Bară de stare pentru desenarea unei linii: 

 
 

Bară de stare pentru desenarea unui poligon: 

 
 
 

Bara de instrumente de desenare în CorelDraw  are următoarea componenţă: 
 

Instrumentul de selectare 
Forme (cuţit, gumă, etc) 
Instrumente de decupare 
Instrumente de vizualizare 
Desenare cu mâna liberă (segmente, linii curbe, linii artistice, etc.) 
Umplere sau desenare inteligentă 
Dreptunghi (pătratul se desenează ţinând tasta Shift apăsată) 
Elipsă (cercul se desenează ţinând tasta Shift apăsată) 
Poligoane 
Forme geometrice de bază 
Text 
Îmbinare interactivă 
Pipetă culoare 
Contur 
Umplere 
Umplere interactivă 
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3.2.4. Stabilirea formatului desenului  
 
În CorelDraw setarea parametrilor se realizează în fereastra afişată după deschiderea unui desen nou 
  

 
 

 

3.2.5. Modificarea proprietăţilor obiectelor în CorelDRAW: 
În CorelDRAW proprietăţile obiectelor pot fi  modificate cu ajutorul ferestrei Properties, fereastră 

afişată fie prin: 
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o Selectarea opţiunii Properties din meniul contextual (click dreapta mouse pe obiectul 

respectiv) 

o Selectarea opţiunii Window – Dockers – Properties 

 

 

 

 

 

 

 

 

3.2.6. Alinierea obiectelor 

 
o Se selectează obiectelor ce se vor alinia 

o Se selectează subopţiunea Align and Distribute a opţiunii Arrange a meniului principal 

o Se selectează, din lista afişată, alinierea sau distribuirea dorită (alinierea se face in toate 

cazurile în raport cu primul obiect selectat) 
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o Dacă se doreşte alinierea faţă de alt element (marginile selecţiei, marginile spaţiului de 

desenare) se va selecta opţiunea Align and Distribute..., iar în fereastra afişată se 

selectează elementul de aliniere din caseta lista, setându-se aici şi ceilalţi parametri 

 
 
 

 
 

 

 

 

 

 

3.2.7. Crearea straturilor  

 
o Selectarea opţiunii Tools/Object Manager din 

meniul principal 

o Afişarea meniului contextual (click dreapta) al 

ferestrei Object Manager afişată  

o Selectarea opţiunii New Layer 

 

o Setarea opţiunilor noului strat (denumire, 

vizibilitate,culoare,etc.) 
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     Fig. 2    Fig. 3 

 

 

 

 

 

 

 

 

3.2.8. Introducerea textului 
În CorelDRAW este posibilă introducerea textului in două variante: 

o Artistic –are mai multe posibilităţi de formatare de tip WordArt din Word 

o Tip  paragraf -text clasic  

 
  

  

 

 Amîndouă pot fi accesate din bara de instrumente 

o După selectarea instrumentului Text diferenţierea celor două tipuri se face 

prin modul diferit de introducere in suprafaţa desenului: 

o Cu un simplu click stanga pentru textul artistic 

o Cu indicare cu mouse-ul a colţurilor opuse a casetei text tip paragraf 
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Ca şi la celelalte instrumente, după selectarea instrumentului text, bara de proprietăţi afişează 

caracteristicile pentru text: 

coordonatele 
primului colţ                   dimensiunea formatarea 
al casetei text buton pentru scară inegală      caracterului caracterelor 

       
 
 

dimensiunile înclinarea      Copiere  Stilul 
scării caracterului      textului       în oglindă     Tipul       textului Alinierea  Editarea 

   -orizontală           -orizontală     caracterului                      textului    textului 
   -verticală            -verticală          

 

Lucrul cu texte poate fi declanşat şi din opţiunea Text a meniului principal: 

Cele mai uzuale operaţii posibile cu ajutorul acestui meniu sunt: 
 

Formatarea caracterelor 

Formatarea paragrafelor: 

-alinierea în paragraf 

-scrierea pe coloane a textului 

-marcatori de linii 

-primul caracter cu format special 

Caseta de editare a textului 

Inserarea caracterelor speciale 

Formatări speciale 

Alinierea textului la o curbă existentă în desen 

Realiniază un text a cărui poziţionare a      

caracterelor a fost schibată la linia de bază (forma 

iniţială) 

Afişarea (sau nu) a casetelor paragrafelor 

            Instrumente text (corectare gramaticală, 

înlocuire a greşelilor de ortografie,etc. 
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3.2.9. Editarea desenului în CorelDRAW: 
 

Aplicația CorelDRAW-ul pune la dispoziţia utilizatorului instrumentele necesare editării unui desen. 

Ele pot fi selectate fie din bara de proprietăţi ale instrumentului de selecţie, fie din submeniul 

Transformations al opţiunii Arrange a meniului principal. 
 

 
 

La selectarea oricărei opţiuni se deschide o fereastra proprie acţiunilor de editare: 

 
 

Fereastra Transformations în varianta Position: 

 
 

Butoanele de selectare a transformărilor 

 

Poziţia pe orizontală 

Poziţia pe verticală 

 

 

Opţiunea de poziţionare relativă (dacă caseta este selectată) – 
noile coordonate se calculează faţă de coordonatele actuale ale 
centrului obiectului (sau ale nodului selectat) 
 
 Acţiunea se aplică unei copii a obiectului 
 Acţiunea se aplică obiectului selectat 
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Fereastra Transformations în varianta Rotation: 
 
 

 

 

 

 Unghiul de rotire (sensul pozitiv este sensul trigonometric) 

 

 

 

 

 

 

 

Fereastra Transformations în varianta Scalare şi Oglindire: 
 

Valoarea scării de transformare pe orizontală 

          Valoarea scării de transformare pe verticală 

 Oglindirea după axa de simetrie verticală 

 Oglindire după axa de simetrie orizontală 

 

 

 

 Scară diferită pentru direcţia orizontală şi cea verticală (în 
cazul selectării casetei) 
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Fereastra Transformations în varianta Mărime (Size): 
Se modifică dimensiunile dreptunghiului de încadrare a obiectului cu valorile indicate 

 

 

Valoarea noii dimensiuni pe orizontală 

Valoarea noii dimensiuni pe verticală 

 

 

 

 

 

 
 
 
Fereastra Transformations în varianta Deformare (Skew): 

 

 

 

 

  Unghiul de deformare pe direcţia orizontală 

  Unghiul de deformare pe direcţia verticală 

(sensul pozitiv este cel trigonometric) 
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3.2.10. Tipărirea în CorelDRAW - Fereastra de previzualizarea 
Caseta de selectare a stilului de tipărire 
 Butoanle de adăugare (+) sau eliminare (-) a unui stil de tipărire 
  Buton pentru setarea opţiunilor de tipărire (afişează fereastra de tipărire) 
   Buton de declanşare a tipăririi 
    Instrumentul cu efect de lupă (identic cu cel al programului) 
     Previzualizare pe întreg ecranul (Full screen) 

Descompunerea în nuanţele componente culorilor standard 
de tipărire (cyan-magenta-galben-negru) 

Buton de inversare a culorilor (ca la negativul foto) 
Butonul de copiere în oglindă a desenului de 
tipărit 
 Buton de închidere al ferestrei 

 
Caseta cu modul de 
aliniere a obiectelor 
pentru tipărire (nu are 
efect în desenul propriu-
zis) 
 
Coordonatele şi 
dimensiunile suprafeţei 
de tipărire 
 
Scara tipăririi (pe 
orizontală, respectiv pe 
verticală) 
 
Buton de uniformizare a 
degradeului în cazul 
alegerii variantei de 
tipărire cu nuanţe cenuşii 
(grayscale 
 
Buton pentru tipărirea pe 
porţiuni a desenului 

 

Instrumentul de 
selecţie (poate fi selectat numai tot desenul de tipărit) 
Instrumentul de impunere a marcajelor pentru tipărire în format ce va suferi o pliere (modul 
de pliere se setează dintr-o subfereastră a ferestrei de tipărire) 

Instrumentul de marcare a suprafeţei tipăribile (dacă nu se folosesc instrumentele de   pe bara de 
proprietăţi) 

Instrumentul lupă 
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Fereastra de setare a parametrilor tipăririi 

 
Datorită multiplelor setări posibile în vederea tipăririi, fereastra cuprinde la rândul ei mai multe 

subferestre: 

Subfereastra General cuprinde elemente asemănătoare (identice) cu fereastra Word de tipărire 
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Subfereastra Layout 

Poziţionarea obiectelor în vederea tipăririi (nu are efect pentru desenul propriu-zis): 
-identic ca în desen  
-scalat să încapă pe întreaga pagină 
-cu anumite poziţionări (ex: centrul paginii) 
Setarea ariei de tipărit de tip dreptunghiulară (prin coordonate şi dimensiuni) 
 

Setarea numarului de linii de 
caroiaj care vor împărţi suprafaţa 
în cazul tipăririi pe bucăţi  
 
Tipărirea pe bucăţi a desenului 
(când dimensiunea desenului 
depăşeşte mărimea formatului de 
tipărire) 
 
Setarea marcatorilor de 
împăturire a desenului tipărit 
 
 
Buton de setare (previzualizare) 
a modului de tipărire în cazul 
formatelor pliate 

Buton pentru afişarea 
ferestrei de previzualizare 

Buton de previzualizare în această fereastră 
 
 
 
 
 
 
 

Subfereastra Separations 

Conţine elemente de setare mai fină a variantelor de palete de culori pentru tipărirea desenelor 
(prin descompunerea în componentele de bază prezentate şi în cazul ferestrei Preview) 
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Permite combinarea a 
câte 2-4 culori de bază 
sau a separaţiei lor 
(selectarea unei singure 
culori) 

 

 

 

 

 

 

 

Subfereastra Prepress 

Elementele principale prezentate în fereastra Preview 
 

 

Tipărire pe: 
-negativ 

-cu imagine oglindită 

Informaţii despre fişier  

Tipărire număr pagină 

Setarea degradeurilor de 
culoare (grayscale) 
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Subfereastra Misc 
 

Permite setări referitoare la ceea ce se va tipări şi ceea ce nu se va tipări din desen 

 

Casetele care sunt selectate 
impun tipărirea elementelor 
respective 

Modul de tipărire a 
culorilor: 
-color 
-alb-negru 
-nuanţe de cenuşiu 
 

Impune o anumită rezoluţie 
pentru imaginile bitmap în 
funcţie de varianta de 
culoare de tipărire aleasă 
(color, nuanţe cenuşii, alb-
negru) 

Modul de tipărire a unei imagini bitmap: 
-nr de paşi pentru tipărira unei umpleri graduale 
-conversia documentului în format bitmap cu rezoluţia specificată (DPI) 

    

Subfereastra Issues 
 

Prezintă lista erorilor de tipărire depistată de program în urma setărilor şi afişează indicaţii pentru 
remedierea lor 
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4. Aspecte referitoare la proiectul ”Designeri și 

graficieni în industria de publicitate” 
 

Proiect de mobilitate din cadrul Programului Erasmus+, Acţiunea KA1, mobilități 

VET, derulat prin Agenţia Natională pentru Programe Comunitare în Domeniul 

Educaţiei şi Formării Profesionale din cadrul Ministerului Educaţiei Naționale - 2014-1-

RO01-KA102-000604 

 

 25 de elevi ai Liceului de Arte ”Sigismund Toduță” Deva au participat la proiectul de 

mobilitate intitulat ”Designeri și graficieni în industria de publicitate”, proiect derulat în cadrul 

Programului Erasmus+, prin Agenţia Natională pentru Programe Comunitare în Domeniul Educaţiei 

şi Formării Profesionale din cadrul Ministerului Educaţiei Naționale. 

 Cei 25 de elevi, din clasele a 11-a, specializările Arte plastice și Arhitectură s-au deplasat în 

Spania și Portugalia, în perioada 4 - 20 mai 2015, pentru a desfășura un stagiu de practică în 

companii de profil, alături de care au avut șansa de a-și dezvolta competențele profesionale, de a 

lucra în echipă și a se forma ca cetățeni europeni, cu șanse sporite de a fi de succes în carieră și în 

demersurile lor academice ulterioare. 

 Profesori însoțitori: Nemeș Ramona – Portugalia; Sîrbu Alina, Leahu Daciana – Spania 

11 Arhitectură – 10 elevi: 

• Deac Diana 

• Buță Diana Maria 

• Nagy Erika 

• Creangă Alexandra Ioana 

• Popa Oliviu Mihai 

• Rozsnyai Dragoș 

• Țenț Miruna - Flavia 

• Ciuberea Robert Sebastian 

• Badinschi Vanessa - Andreea 

• Hui Răzvan – Cătălin 
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11 Plastică – 15 elevi: 

• Muller Maria Isabela 

• Gligor Vlad Nicolae 

• Dohan Elena Bianca 

• Bondoc Bianca Ionela 

• Faur Bianca Sorina 

• Manolache Anca Elena 

• Becheș Robert Ioan 

• Luca Francesca Xia 

• Smeu Gabriel Mihai 

• Ardelean Muntean Miruna 

• Lăscău Cătălin Viorel 

• Josan Denisa Maria 

• Duma Octavian Călin 

• Tănase Bruno Florin 

• Cornea Aurelia Alina  

Grup Portugalia 

 

 

Grup Spania 
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Achiziții 

• Dezvoltarea  

- competențelor profesionale 

 - abilităților sociale  

 - competențelor lingvistice în limba engleză 

 - achiziții lingvistice - cuvinte, fraze și expresii - în limbile spaniolă și portugheză.  

 -  îmbogățirea orizontului cultural cu fiecare experiență trăită și fiecare loc nou pe care l-au 

vizitat 

 

Validarea și recunoașterea rezultatelor 

• Prezentul proiect a asigurat, prin cele 60 de ore de practică desfășurate în companiile din 

țările gazdă, formarea competenţelor cheie şi a competenţelor specifice, prevăzute prin 

curriculumul școlar pentru clasa a XI-a, disciplina "Procesarea computerizată a imaginii". 

• Elevii au primit, la întoarcerea din stagiu, 3 note în urma procesului de validare și 

recunoaștere a rezultatelor învățării. 

 

Certificate obtinute 

• Europass Mobility 

• Certificatul lingvistic  

• Certificatul de participare 
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5.  Produse ale activității - materiale publicitare 

realizate în cadrul proiectului 
• Sticker-e, banner-e, cărți de vizită, afișe publicitare, flayer-e, editare de imagine și alte 

activitați desfășurate de grupul de participanți din Portugalia la firma de publicitate Chapa5 

din Barcelos: Deac Diana, Creangă Alexandra Ioana, Popa Oliviu Mihai, Țenț Miruna – 

Flavia, Dohan Elena Bianca, Bondoc Bianca Ionela, Luca Francesca Xia, Lăscău Cătălin 

Viorel, Cornea Aurelia Alina  
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• Realizare	
  montaj	
  video	
  

o Anca Manolache, Bianca Faur, Miruna Ardelean - 

https://www.youtube.com/watch?v=mR556IFJpDg 
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• Afișe publicitare cuprinzând activitățile elevilor Școlii Secundare din Barcelos,  

 realizate cu ajutorul aplicațiilor Adobe Photoshop și Corel Draw 

 

 

 

• Bloguri despre Granada – Spania 

o Diana Buta, Erika Nagy, Vanessa 

Badinschi 

http://storiesalongtheroad.tumblr.com   
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o Dragos Rozsnyai, Razvan Hui, Robert 

Ciuberea, Gabi Smeu 

http://sarmalereci.tumblr.com	
  	
  

	
  

	
  

	
  

	
  

	
  

	
  

	
  

	
  

	
  

o Maria Muller, Denisa Josan 

http://artdesigngranada.tumblr.com	
  	
  

https://artdesigngranadamep.wordpress.com/?ref=spelling	
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o Robert Becheș, Vlad Gligor, 

Bruno Tănase, Tavi Duma 

http://deepingranada.tumblr.com	
  

 

 

 

 

 

 

 

 

o Anca Manolache, Bianca Faur, 

Miruna Ardelean 

http://mepinfo.blogspot.com.es 
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• Realizare broșuri, pliante, cărți poștale, alte  materiale publicitare 

o Diana Buta, Erika Nagy, Vanessa Badinschi 

 

  

Contact organizații partenere: 
• SPANIA - Granada 
https://www.facebook.com/mep.europrojectsgranada?fref=  
• PORTUGALIA - Barcelos 
http://mobilityfriends.org/  
• DEVA – Liceul de Arte “Sigismund Toduță” 
http://artedeva.ro 
• Agenția Națională  
http://www.anpcdefp.ro/anpcdefp.php?link=61 

• CHAPA 5 Barcelos 
https://www.facebook.com/Chapa5BARCELOS/timeline?ref=page_internal 

• DSI Spain  
http://www.dsispain.es 

• Red Global Assessores Informaticos, Spain 
http://www.redglobalai.com 

Exterior 
part  

Interior 
part 


